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Introduction to Novell GroupWise 6.5 
GroupWise 6.5 is the new version of email and calendar software supported by Pensacola Junior 
College.  This version of GroupWise has the capabilities of the past version used on campus; 
however, there are some new features to GroupWise 6.5.  It now offers easier proxy features, 
enhanced Address Book aspects, improved Calendar views, the ability to assign Categories to an 
email, as well as other useful features for the user. 

Getting to Know Your Main Window 
The Main Window in GroupWise is your main work area.  It is in this window that you are able 
to read your messages, schedule appointments, manage your contacts, view your Calendar, open 
folders, open documents, and change the GroupWise mode you are running as well as many 
other tasks. 

Toolbar 

The GroupWise Toolbar is context-sensitive and changes to give you options according to the 
task you are trying to perform.  It contains the Display drop-down menu and shortcut buttons, 
which allow you to perform common tasks quickly such as opening an Address Book or create 
other items.  You can display the name of the button on the Toolbar by placing the pointer over 
the icon. 

Display and Customize the Toolbar 

1. Place cursor on Toolbar in the area 
Containing the icons for Address Book, 
New Mail, etc. 

2. Right-click. 
3. Click Customize Toolbar 
4. Click the Show tab 
5. Click the options for how 

you want to display the toolbar 
6. To customize the Toolbar further, 

Click on the Customize tab and 
 select the options you want 
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GroupWise 6.5 Enhancements 
Function Enhancement 

Main Mailbox Main Mailbox toolbar is now context-sensitive.  The 

toolbar buttons change depending upon the folder you are 

accessing (e.g. Sent Items, Calendar, Cabinet). 

Item Context Item Context toolbar changes depending upon the item 

you are working with. 

Message List The Message List now contains new icons.  The envelope 

icon will reveal whether you have replied to a message or 

forwarded a message without going to your Sent Items 

folder or without viewing details.   

Folder List 

 

The Folder List contains the following items: 

Sent Items looks like an outbox. 

Contacts folder is a duplicate of your Frequent Contacts 

Book.  You can change it to represent a different address 

book in the Address Book by changing the folder 

properties. 

Check List is a new folder that allows you to create a task 

list.  Items such as mail, phone messages, reminder notes, 

tasks, or appointments can be moved into this folder.  

Items are marked with a check box so that items can be 

checked off as they are completed. 

Main Window A new enhancement of GroupWise 6.5 is the capability to 

open more than one Main Window at a time. This allows 

you to view your own Main Window and the Main Window 

of someone you may be proxying for. You may also want to 

open your Calendar in one Main Window while having a 

folder open in another Main Window. You may open as 

many Main Windows as your computer memory is able to 

manage. 
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Getting to Know Your Mailbox 
Your GroupWise Mailbox stores all of your Mailbox items.  These items include those which 
have been received, sent, posted, or drafted.  Different icons are used with GroupWise 6.5 to 
represent different types of messages and to reflect changes in the status of messages.  You 
should be able to distinguish between the different types of messages by glancing at the icons in 
your mailbox.  You can also tell whether a message has any file attachments or if you have 
opened a message already.  You can manage the Mailbox by organizing messages within folders 
in your Cabinet and creating new folders as needed. 

Mailbox Icon Table 
Icon What it Means 

  Indicates one or more items are attached to the item 

  Indicates an item you have sent 

 Indicates this is an item you have replied to. 

 Indicates a forwarded item. 
Two Wavy Arrows pointing in 
different directions 

Indicates a reply is requested 

 Indicates an item you have replied to and forwarded 

 Indicates a posted item. 
 Indicates a Sent item opened by at least one person.  This 

icon will remain until all recipients have:1) opened the 
mail, phone message, or reminder note; 2) accepted the 
appointment or 3) completed the task. 

 
Indicates an item you have sent which could not be 
delivered to the destination post office or it did not transfer 
to the Internet. 

 Appears next to an item you have sent. Next to an 
appointment or task, this icon indicates that at least one 
person has declined/deleted the item. Next to a mail 
message, phone message, or reminder note, this icon 
indicates that at least one person has deleted the item 
without opening it. 

 Indicates an unopened mail message with a low, standard, 
or high priority. 

 Indicates an opened mail message with a low, standard, or 
high priority. 

 Indicates an unopened appointment with a low, standard, 
or high priority. 

 Indicates an opened appointment with a low, standard, or 
high priority. 
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 Indicates an unopened task with a low, standard, or high 
priority 

 Indicates an opened task with a low, standard, or high 
priority. 

 Indicates an unopened reminder note with a low, standard, 
or high priority. 

 Indicates an opened reminder note with a low, standard, or 
high priority. 

 Indicates an unopened phone message with a low, 
standard, or high priority. 
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Working with GroupWise Messages 
GroupWise is more than just an email system.  In addition to email, it deals with several types of 

messages such as phone messages, appointments, tasks, reminder notes.  You can send all of 

these message types to other users as well as use them to keep track of your own schedule. 

 

Mail Messages 

A mail message is the same as an email.  It contains fields for the recipient, a subject, a date and 
other fields where you can specify recipients of carbon copies and blind carbon copies. 

 

Creating a Mail Message 

To create a mail message click the New Mail icon on the Toolbar.   

You can also select File > New > Mail from the menu bar. 

 

Appointments 

Appointments are used to post appointments or meetings.  Posted appointments are Calendar 
entries used to block out times in your Calendar when you are busy with other tasks or 
appointments. 

Appointments you schedule for yourself are placed in your Calendar on the date you selected.   
 
To create and post an appointment you can perform any one of the following procedures: 
 

1. Click on File > New > Appointment  
Or 

2. Click the New Appointment button on the Toolbar 
Or 

3. Click on the down-arrow button next to the Appointment icon on the Toolbar > Click 
Posted Appointment 
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Meetings 

Meetings are group appointments that you can use to schedule meetings with other users of 
GroupWise.  Whenever another user sends you a request for a meeting, the meeting automatically 
moves to your Calendar when you accept it.  If you do not accept the meeting request, the message 
status information returns to the sender’s Sent Items folder telling the sender that you have declined 
the meeting. 

 

Tasks 

Tasks are to remind you about an important job you need to accomplish.  When creating a task, you 
specify the start date for the task and the due date for the task.  Tasks appear in your calendar and you 
must mark it complete with a check mark in the check box once you have completed it.  If you do not 
mark it, the task will continue to remain incomplete, moving over to the next day.  If the task is 
overdue, the status changes to red to indicate that it is overdue. 

To create a task: 

Click on the down-arrow button next to the New Task icon on the Toolbar > Click Posted Task. 
 

Tip:  Tasks are somewhat related to the Checklist folder.  They are both used to keep track of items 
that need to be dealt with.  A task will not display in the Checklist folder unless you place it there.  
Information about the Checklist folder is discussed this manual in another section. 

Scheduling a Task for Yourself 
Open your calendar in a view that contains a Task List.   

Click a date, and then double-click anywhere there is an empty space in the Task List.   

1. Type a subject for your task.   

2. You may desire to type a priority for the task however this is optional.  The task priority can 
consist of a character followed by a number.  Acceptable formats would be:  A1, C1, B, 3, etc.   

3. You must type a date for the task to begin and a date for the completion of the task.  The same 
date can be typed in both boxes.   

4. You may click on the calendar icon to specify dates or auto-dates for your task.   

5. Type a message.   

6. Post the task by clicking Post on the toolbar.   

7. Posted tasks are placed in your Calendar.   
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Marking a Task Complete 

Once you have completed a task, you can mark it Completed.  The completed task will no longer be 
carried over to the next day.  You mark a task by clicking in the box which will assign a check mark to 
the box to signify completion.  Whenever a task is overdue, it is displayed in red.   

 

Categories 

You can also organize your messages and contacts by assigning categories to them.  This provides a 
way to organize your items.  You can create and add categories as well as give each category an 
identifying color.  The colors display in the Calendar and in the Item List. 

An item can have more than one category assigned to it.  You can identify which category is the 
primary one.  The item will be identified by the color of the primary category.  

There are four default categories you can assign to items: 

1. Follow-Up 

2. Priority 

3. Personal 

4. Urgent 

You can choose not to use these default categories.  If you choose not to use them, you are able to 
modify or delete them.  You may also create new categories.  Other options for managing Categories 
are: 

• Filter categories 

• Add a column heading to a category 

• Sort an item list by category 
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Placing an Item in a Category 

The Category option allows you to place any items such as Mail Messages, Appointments, Reminder 
Notes, or Contacts into a category.  You can move items in and out of categories as desired.  In order 
to place an item in a category you must: 

1. Click the folder you want to work in from the folders in the Folder List. 

2. Click the item you want to place into a category. 

3. On the GroupWise main menu bar, click Actions. 

4. Choose Categories. 

5. Click the category to which you want the item to belong. 

 

Another way to place an item in a category is: 

1. Right-click the item you will be placing in a category. 

2. Choose Categories. 

3. Click the category for which you want the item to belong. 

 

Yet another way to place an item in a category is: 

1. In any open Mail Message or Appointment, click the Personalize tab. 

2. Click the multi-colored button which is located next to the Category field. 

3. Click one or more of the category names. 

4. You can exit the Category field by clicking anywhere in the message. 
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Creating a New Category 

GroupWise offers four default categories for the types of items you may receive.  You may want to 
create new categories beyond the default categories in order to meet your individual needs. 

1. To create a new category: 

2. Select an item you want to place in a new category. 

3. Right-click on it.  

4. Choose Categories 

5. Click on More....  

6. Click inside the box where you see the words <Type here to add a new category>.  

7. Type the name of the category you want to create.  

8. Click Add.  (Notice the category name you just typed was added to the Categories list.) 

9. Click Edit Color.  A color palette appears with an array of colors from which to choose. 

10. Click the color you want items in that category to appear in.  

11. Click OK  

 

Another way to create a new category is: 

1. In any open e-mail item such as Mail Message, Appointment, click the Personalize tab.  

2. Click Edit Categories.  

3. Click inside the box where you see the words <Type here to add a new category>.  

2. Type the name of the category you want to create.  

3. Click Add.  

4. Click Edit Color.  A color palette appears with an array of colors from which to choose. 

5. Click the color you want items in that category to appear in.  

6. Click OK 
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Filtering a Folder by Category 
Items placed in a category can by filtered by that category.  You can add a Category column heading 

and sort your item list by category.  Filtering hides the other items from view in the folder; it does not 

delete the other items.  When you clear the filter, all the items that were hidden reappear.  Once you 

have finished working with the filtered list, you can turn off the filter to view the folder's entire 

contents again. 

1. In the Folder List, click the folder you want to filter.  

2. At the top right of the folder's item list, click Show: 

3. Click the category of the items you want to view.   

4. To view all the items in the folder again, click All Categories.  
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Getting to Know Your Folder List 
The Folders List is displayed in the left frame of your GroupWise Main Window.  The Folder 
List contains all the folders you have created within your GroupWise account as well as all of the 
following default folders: 

 
Mailbox receives all incoming email items. 
 
Sent Items folder looks like an out tray and contains all the items sent from your GroupWise 
account. 
 
Contacts Address Book is a new Address Book.  It is a duplicate of your Frequent 
Contacts Book and provides easy access to any personal address book you have designated for 
the Contacts Folder. 
 
Check List is a new folder that allows you to create and prioritize a task list..  Items such as 
mail, phone messages, reminder notes, tasks, or appointments can be moved into this folder.  
Items are marked with a check box so that items can be checked off as they are completed. 

 

Calendar folder opens your GroupWise Calendar.  It allows you to manage your schedule and 
track your Appointments, Tasks, and Reminder Notes.  The GroupWise Calendar enables you to 
check other GroupWise users’ availability with the Busy Search feature, create new items from 
your calendar and view your schedule by day, week, month, or year. 

 

Checklist Folder is a new folder that allows you to create a task list.  You can move any 
items (mail messages, phone messages, tasks, appointments, or reminder notes) to the Checklist 
folder and arrange them in any manner preferred.  Items are marked with a check box so that 
items can be checked off as they are completed. 

 

Task List folder collects and displays all tasks assigned to you.  The tasks will continue to 
appear elsewhere in your account as well as appear in the Task List folder. 

 

Work In Progress folder stores items you have not finished composing. 
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Cabinet folder stores personal folders you have created for organizing your mail. 

 

Junk Mail folder must be enabled.  When enabled, the Junk Mail folder holds all items from 
senders who have been added to your Junk Mail List. 

 

Trash folder holds all items deleted from other folders 

 

Creating a New Folder 

You can create new folders in order to help keep the items you receive organized or to keep your 
Mailbox from becoming too crowded.  Items can be organized according to date, topic, project, 
or sender. 

 

To create a new folder: 

1. Right-click the Cabinet folder. 

2. Choose New Folder. 

3. Click Personal Folder. 

4. Click Next. 

5. Type the name of the new folder. 

6. Click Next. 

7. Click Finish. 

8. Your new folder now appears in the Cabinet folder as a subfolder 

9. You can now move your mail into the new folder by dragging it with your mouse from 
the message window. 
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Sorting a Folder 

Folder items are sorted automatically by the date they were sent or received with the earlier 
messages displayed first.  You may sort your messages by another category. 

 

To sort your folders: 
1. Click the folder you want to sort in order to display all messages of that folder in the 

Main Window. 

2. Click the “Name” section located at the top of your Main Window. 

3. The category will be sorted in an ascending order such as A-Z or 1-9. 

4. You can change the sort to a descending order by clicking the category head again. 

5. You can change back to the default setting by clicking on Date. 

Calendar  
You can access your GroupWise calendar by clicking on Calendar in your Folder List.  You may 
also use the Open Calendar button on the main button bar to open your calendar. 

Navigating the Calendar 

The calendar displays the Day view by default whenever you open it.  Your Appointments, Reminder 
Notes, and Tasks for the day will be displayed.  Whenever you open the calendar from the Folder List, 
you will see the navigation bar for the calendar.  You can navigate around your calendar by using the 
Arrow Buttons on the navigation bar.  You may click forward or backward according to the number 
of days you wish to move.  For instance, to move ahead one day, click on the 1 button, to move ahead 
one week, click on the 7 button, etc.  The 31 button moves you ahead one month and the 365 button 
moves you ahead one year.  Use the same process for moving backward through the calendar. 

Changing the Calendar View 

You may view your GroupWise calendar schedule by day, week, month or year by clicking the 
corresponding button on the navigation bar. 

1 – View the calendar by day 

7 – View the calendar by week.  

31 – View the calendar by month 

365 – View the calendar by year 
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Filtering for Item Types 

Your GroupWise calendar allows you to view individual items on your calendar such as Tasks, 
Appointments, or Notes.  You may choose to display the item or you may choose to hide the item.  To 
view an item, click on the item type until the corresponding button looks as if it has been depressed.  
To hide the item type, click the corresponding button again.   

Appointment Icon – shows/hides appointments 

Task Icon – shows/hides tasks 

Notes Icon – shows/hides notes 

 

 Viewing Additional Days of the Week 

You may choose to view more days in the Week view.  In order to add more days to your calendar 
Week view, click on the plus sign. You can subtract days from the view by clicking on the minus sign. 

 

 Button Bars 

The Button Bars within GroupWise are context sensitive.  Many of the calendar options mentioned 
can be accessed by using the context sensitive button bar available when you click Calendar in the 
Folder List.  Click the item you want to manage and a set of options for that particular item will 
display on the button bar.  For example, when you highlight a new Appointment, you receive the 
options that would pertain to appointments such as Reply, Accept, Decline, and Delegate. 

 

The Task button bar displays the same options as the Appointment button bar except it gives you the 
added option to mark the Task completed. 

The options will appear grayed out if you highlight an accepted item.  When opening the Calendar 
from the main button bar you will only have the option to Delegate, however, it adds other options 
such as Create a New Task, Schedule a New Appointment, and conduct a Busy Search. 
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Calendar Icon Table 
 

Icon What it Means 

 Indicates an alarm is set for the item. 

 Indicates a group appointment, task, or reminder note. 

 Indicates a private item. 

 Indicates you declined an item however, you did not delete 
it. 
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GroupWise Address Book 
The Address Book  is a management tool for your contacts.  You can use it to store names and 
addresses, email addresses, phone numbers and other details about your contacts.  The Address 
Book can be accessed in one of three ways:  Address Book icon, Address Selector, and the 
Contact Folder. 
 

Address Book Icon  

  Click on the Address Book icon on the Main Toolbar to open the Address Book.  The address 
books available to you are in the Left Pane instead of Tabs for each address book as in the older 
version of GroupWise.  The Right Pane of the window displays the list of names and addresses 
within whichever book you have opened. 

 
Note:  Choose a different address book by clicking on the book located in the Left Pane. 

 

Locate a Contact: 

Select the field type from the Inside field.  The following example shows the various fields 
available such as Department, E-Mail Address, etc.  If you choose to search by Name, you will 
type the name in the Look For field of the contact you want to locate from the address list.  The 
address book will locate the name by responding alphabetically to your typing. 

 
 
 
 
 

Inside Field 

Look For Field 
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Address Selector  

 Open the Address Book from a New Mail message by clicking on the Address icon on the 
Menu bar of the new mail message.  The Address Selector window will open providing options 
to allow you to select a contact, add contacts, edit contacts, or create a group.   
Note:  You can change to a different Address Book by clicking on the drop-down arrow at the 
end of the Look in address book:  field. 
 
Add a contact in Address Selector 

1. Click the drop-down arrow in the Look in address book field to choose an address book.  
(Note:  You cannot add a New Contact to the Novell GroupWise Address Book, only 
other address books such as Frequent Contacts or others you have created. 

2. Select New Contact button from the menu. 

3. Add as much information as desired about your contact.. 

4. Type the corresponding information in the field. 

Edit a contact in the Address Selector 

1. Select a contact from any of the address books. 

2. Click the Details button located below the Address List. 

3. Edit or add information about your contact. 

 

Save a Group in Address Selector 

1. Double-click on a contact from any of the address books. 

2. Notice the contact is added to the Right Pane of the Address Selector window. 

3. Continue to click on any contacts you wish to add to the group. 

4. After you have added all the contacts you want for the group, you may save the group. 

5. Note:  You may remove contacts by clicking on the Remove button at the bottom of the 
Right Pane. 

6. Name the group by clicking the Save Group. 

7. A new window will pop up with the name of the Address Book where you will be saving 
the new group. 

8. Type a name for your group and add any comments about the group. 
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Signature 
You can insert a signature or a tag-line on items you send from your GroupWise account.  The 
signature places itself at the end of the item you send.  You can have GroupWise automatically 
place your name, department, phone number, email address or any other information you deem 
necessary on every item you send.  You may choose to be prompted as to whether or not you 
want to add the signature to each item or you may choose to have it automatically add it to your 
sent item.  In order to add a Signature to your items you should: 
 

1. Click on Tools from the GroupWise main window 
 

2. Choose Options 
 

3. Double-click on the Environment icon 
 

4. Click the Signature tab 
 

5. Choose the radio button for Automatically add 
            or Prompt before adding. 
 

6. Type the information you want in your Signature 
            box. 
 

7. Click OK 

 
 

Superman 

1.800.WhyUFly 

 
 

Superman 

1.800.WhyUFly 
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GroupWise Item Types 

Rules 
You can use Rules to automate many actions within GroupWise.  Rules can perform tasks such as 
reply when you are out of the office, sort items into folders, delete items, etc.  When you create a rule, 
you are defining a set of conditions and actions that will be performed when an item meets those 
conditions.  You must perform the following steps to create a rule: 

1. Name the rule 

2. Select an event, which will be the trigger that starts the rule. 

3. Select the types of items affected by the rule. 

4. Add an action, which is what you want the rule to do when triggered. 

5. Save the rule 

6. Enable the rule 
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Vacation Rule 

The vacation rule allows your email account to respond to incoming mail to let the sender know that 
you are out of the office.  In order to create a vacation rule, perform the following steps: 

1. Click Tools > Rules > New 

2. Type a name for your vacation  

rule in the Rule name box.   

Vacation Rule is a good name for it. 

3. Click When Event is list and  

choose New Item. 

4. In the And items are: area > 

Click in the Received box.   

This will place a check mark 

 in the box.  Make sure no  

other item sources are selected. 

5. Under the If conditions are > Item Types: area, click in the Mail box.  Again, this will place 
a check mark in the box. 

6. Click on Define Conditions…box to define specific conditions to your rule. 

7. In the “Then actions are” area, click the Add Action button click Reply. 

8. A Reply box will open. > Click the radio button for Reply to sender . 

9. Click in the box beside Include message received from sender if you want the original 
message included with the Reply > Click OK. 

10. Another box entitled Reply will pop up.  You may add a subject to your reply in the Subject: 
area.  Type the message you want to go out with the Reply. > Click OK > Save 

11. The Rules dialog box will come back up.  Click in the box next to the new rule which will 
place a check mark in the box.  This check mark enables the rule. > Click Close. 

12. Use Define Conditions to add specific information to you rule. 

Important Note:  Vacation rules will not stop you from receiving mail messages sent to your 

mailbox.  They will only let others know you are not in the office.  
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Proxy Access 
One definition of the word “proxy” is the management of another person’s affairs.  Proxy allows you 
to manage another user’s Mailbox and Calendar within the same GroupWise system.  You can 
perform actions such as accessing another user’s Mailbox in order to read messages, viewing the 
user’s Calendar, scheduling appointments, posting tasks, sending notes, or accepting and declining 
items within the restrictions set up by the other user.  The proxy is only possible if the other user has 
granted rights to his or her Mailbox.  Managing someone else’s schedule is simplified since you have 
direct access to the other user’s GroupWise calendar. 

Granting and Accepting Proxy Rights 

There are two steps to complete in order to grant proxy rights to another user.  The first step is for 
User A to grant User B the right to proxy into his/her account.  The second step is for User B to add 
User A’s account to his/her proxy list.  Here is how you would do this: 

Step 1:  Granting Proxy Access (User A to do) 

You must follow these steps to allow another GroupWise user to proxy into your account: 

1. From the GroupWise menu bar choose Tools then choose Options 

2. Double-click on the Security icon. 

3. Click the tab labeled Proxy Access 

4. Type the name of the GroupWise user you want to give proxy rights.  You can also click on 
the address book icon to find the user’s name in the GroupWise address book. 

5. Click Add User. 

6. Click the user’s name under Access List: 

7. Here is where you will select the access rights for the user you chose.  For example, if you 
only want to grant access to your schedule but not your Mail Messages, you would select 
“Read” and “Write” for Appointments, Reminder Notes, and Tasks. 

8. Click OK and then click Close. 
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Step 2:  Accepting Proxy Access (User B to do) 

You must follow these steps to add another GroupWise user to your proxy list: 

1. From the top of your Folder List on the left-hand side of your GroupWise window, click 
Online. 

2. Click Proxy… 

3. Click the tab labeled Proxy Access 

4. Type the name of the GroupWise user whose account you want to proxy into.  It is important 
that you type the name of the user exactly as it appears in GroupWise.  You can also click 
on the address book icon to find the user’s name in the GroupWise address book.. 

5. Click OK. 

 

Proxying into Another Account 
GroupWise 6.5 proxy features are basically the same as previous versions of GroupWise, however, its 

location has changed in order to make access more convenient for the user.  Click on the Proxy icon at 

the top of the Folder List.  A drop-down menu will appear.  Choose the account for the user you want 

to proxy.  You can also access the same proxy list from your calendar.  Whenever you proxy into 

another user’s account from your calendar,  

you will see that user’s calendar. 
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Sending Items as a Proxy 

You can now send an email, appointment or 

a task from an account for which you have  

proxy by staying within your own account and 

sending it from your directly from there. 

In order  to do this, you must clickthe From button 

next to your name in any outgoing  item.   

Choose the account from which you want to  

send the message. 

 

WebAccess 
PJC faculty and staff can use the Internet to access their GroupWise e-mail accounts from a home 
computer or any computer with an Internet connection.  The Web version of GroupWise is very 
similar to the campus network version containing most of the same features.  GroupWise 6.5 allows 
you to access your proxy calendars from off-campus.  To access your GroupWise account from an 
off-campus computer, type the URL http://gw.pjc.edu.  You may now login using your username and 
password. 

Important note:  Before you can use the WebAccess version of GroupWise, you must have a 
password set for your mailbox.  If you have not set a password for your GroupWise account, you must 
perform the following steps on a computer on the PJC campus: 

 

1. Open your GroupWise account while on campus 

2. Click on Tools > Options > Security 

3. Type the password you would like to use. 

4. You should now be able to access your account while off campus. 
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GroupWise 6.5 Help  
GroupWise 6.5 offers a very thorough online help guide which can be accessed from within 
GroupWise.   

1. Click on Help on the Main Menu.   

2. Click on User Guide, which will open the Novell Internet site containing the 
GroupWise 6.5 Windows Client User Guide.  The guide is divided into sections 
enabling you to choose whichever topic you need to access. 


